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Installation Instructions 
 
If you are installing from the MathTutor CD-ROM 
 
(a)  Insert the MathTutor CD-ROM into your CD-ROM drive.  The 
  MathTutor Installation Launcher menu will appear. 
 

(b)   On the menu, in the section labeled "Step 1 - Select Version", 
 click "Deluxe Versions".  Then, in the section labeled  
 "Step 2 - Select Title", click the program you wish to install. 
 

(c)    Click the "Install" button. 
 

(d)   Enter the installation password for the program you have selected,  
 then click OK.  NOTE: The installation passwords can be found  
 on the back cover of the CD-ROM sleevecase. 
 

(e)   Follow the instructions on the screen.  When the installation is 
 complete you will return to the MathTutor Installation Launcher 
 menu.  You may then install another program, or quit. 
 
If you are downloading the program from the MathTutor website 
 
(a)  Visit the download page of our Web site: 
 

http://www.mathtutor.com/download.html 
 
(b)   Scroll down to the section titled "Downloads - Deluxe Versions". 
 In the box with the heading "Special Topics Series" click 
 the "Program" link to the right of "ADVANCED BUSINESS MATH". 
 

(c)   If a dialog box appears and asks if you wish to “Save” or “Run”, 
 select “Save”.  Be sure to note where the installation file is saved. 
 

(d)   Double click the installation file you just downloaded.  The installation 
 process will begin.  Follow the instructions on the screen.   
 
 
System Requirements 
 
* Windows XP, Windows Vista, Windows 7/8, Windows 10 
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Starting a MathTutor Program 
 
 

1. Click the Start button on the Windows taskbar.  The Start menu 
 opens. 

2. Choose Programs.  The Programs folder opens. 

3. Choose Intelligent Tutor. 

4. Click the program you wish to run.  The program will then begin, 
 and the title screen will appear.  Click the title screen to continue. 

5. The Student Login screen will appear.  To keep records for this 
 session, select a name and click Login.  If you prefer to not keep 
 records for this session, click Skip Login. 

6. Use the main menu to select a lesson you would like to study,  
 then click "Start Lesson". 
 
 
 
 

Each of the lessons in these programs contains four sections.  The 
Concept section allows you to learn the main concepts of the lesson.  
The Examples section shows examples.  The Practice section allows 
you to practice problem solving.  And the Test section allows you to 
take a lesson test.  A navigation bar to the right of the lesson window 
allows you to move between these four sections. 
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Overview - ADVANCED BUSINESS MATH 
 
 
ADVANCED BUSINESS MATH is a complete and self-contained course 
designed especially for students and others engaged in self-study.  It will allow 
you to work at your own pace, using easy to follow tutorials and problem solving 
exercises. 
 
ADVANCED BUSINESS MATH was designed by math educators, and is 
comprehensive yet simple to use.  It covers all the topics normally taught in a 
one-semester course in advanced business mathematics.  Our goal is to build your 
math skills and make you more confident about using math in business and 
financial settings. 
 
The lessons in ADVANCED BUSINESS MATH will provide you with a 
dynamic and unique learning experience.  Graphics and animation are used 
throughout the lessons to present the ideas of math clearly and concretely. 
 
Although the lessons are designed to be worked in order, you can study them in 
any order you wish.  Easy to use menus allow you to go directly to any of the 
lessons in the program. 
 

NOTE ON FINANCIAL TABLES NEEDED TO SOLVE PROBLEMS 
 

Many of the problems in this program require you to refer to tables 
such as amortization tables, present value tables, and compound interest 
tables.  You can access all of these tables from within the program as follows: 
 
- Open the "Help" menu at the top of the screen 
- Select "View Tables" 
 
A pdf document containing the tables will appear.  It can be minimized and 
moved so you can refer to the lesson window while using the tables. 

 
 

The Recordkeeping System 
 
This program’s recordkeeping system gives teachers a powerful tool for monitoring each 
student’s use of the program.  Before it can be used, the teacher must create a student list 
of one or more names.  The instructions for doing this, and for using the other features of 
the recordkeeping system, are found starting on page 10. 
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ADVANCED BUSINESS MATH - Topics Covered 
 
 

MATHEMATICS OF 
BUYING 

BUSINESS AND CONSUMER 
LOANS

Invoices and Trade Discounts Open End Credit and Charge Cards 
Single Discount Equivalents Installment Loans 
Cash Discounts: Ordinary Dating Early Payoffs of Loans 
   Method Personal Property Loans 
Cash Discounts: Other Dating Methods Real Estate Loans 
  

MATHEMATICS OF SELLING TAXES AND INSURANCE 
Markup on Cost Property Tax 
Markup on Selling Price Personal Income Tax 
Markdown Fire Insurance 
Turnover and Valuation of Motor Vehicle Insurance 
   Inventory Life Insurance 
  
SIMPLE INTEREST DEPRECIATION 
Basics of Simple Interest 
Finding Principal, Rate, and Time 
Simple Discount Notes 
Discounting a Note Before  
   Maturity 
 
COMPOUND INTEREST 
Compound Interest 
Savings Accounts: Daily Interest 
Present Value 

Straight Line Depreciation 
Declining-Balance Method 
Sum-Of-The-Years Digits 
Units-of-Production Method 
MACRS Method 
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Using the Program 
 
 

 
 
The program menu (shown above) is the starting point for your study of business 
math.  The CHAPTER window shows the chapters in the course.  The LESSON 
window shows the lessons in the current highlighted chapter.  To see a list of the 
lessons in a different chapter, click that chapter in the CHAPTER window. 
 
To study a lesson, click the lesson in the LESSON window.  Then click the START 
LESSON button at the bottom.  Your lesson will then begin! 
 
The beginning student is encouraged to work the chapters and lessons in order.   
But the program gives you the freedom to study the lessons in any sequence you 
wish. 
 
As you work your way through lessons, and try your hand at solving problems, 
you may wish to see a summary of how well you are doing in the current session.  
The RECORDS menu allows you to see a summary of your performance in the 
current session.  It is explained later in this manual. 
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Working a Lesson 
 
After entering a lesson, you can move through the lesson at your own pace by 
clicking the “CONTINUE...” button at the bottom of the window.  To return to the 
program menu click the “EXIT LESSON” button at the bottom of the window.  To 
restart the current lesson use the File menu and select “Restart Lesson”. 
 
Most lessons have a similar format.  First, the main concepts and ideas are 
presented.  Then, one or more examples are presented to illustrate the concepts.  
After seeing these you will be asked if you would like to see another example.  If 
you click "Yes" you will be shown another example.  You will be able to see as 
many additional examples as you wish.  If you click "No" you will be shown a 
problem to solve. 
 

 
 
 
Here’s a tip: When you are in a lesson, if you wish to go straight to solving problems 
click the “Try Problems” button in the right margin. 
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Working a Lesson (continued) 
 
Trying to solve problems is one of the best ways for you to build your math skills, 
so we encourage you to spend some time on problem solving in each of the 
lessons you study.  After trying a problem you'll have a chance to see the program 
solve the problem you just tried. 
 
 
 

 
 
 
When the program presents a problem for you to solve, the possible answer 
choices will be displayed in a multiple choice format.  To select an answer, click 
one of the answer choice buttons in the left margin. 
 
The program will respond by telling you if your answer was correct or incorrect.  
The options available to you at this point are shown below. 
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Working a Lesson (continued) 
 
 
 

 
 
 
After doing a problem, select one of the 
options shown to the left. 
 
Most of the choices are self-explanatory. 
 
If you did not solve the problem correctly, 
and would like to see how it can be solved, 
select the third option choice: “See an 
explanation of this problem”. 
 
 
 

 
 

Summary of How to Navigate a Lesson 
 
 
 In order to do this, then... Do This 
 
Proceed sequentially through a lesson Click the “Continue...” button 
 
Go directly to doing problems Click the “Try Problems” button 
 in the right margin 
 
Select an answer to a problem Click one of the answer choice  
 buttons (A, B, C, D, E) in the 
 left margin 
 
Restart the current lesson Choose “Restart Lesson” from 
 the File menu 
 
Return to the program menu Click the “Exit Lesson” button, or 
 choose “Return to Menu” from 
 the File Menu 
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Looking at Your Performance in the Current Session 
 
 

The RECORDS menu allows you to 
see your performance during the 
current session. 
 
Select “See Session Records” to see 
your performance. 
 
Select “Clear Session Records” to 
erase this sessions records. 
 
 
 

 
The screen below shows how the current session’s records are displayed. 
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The Recordkeeping System 
 
Overview 
 
This program’s recordkeeping system provides teachers with a complete history of each 
student’s use of the program.  Here’s how it works.  As students use the program, the 
following information is automatically stored in the Student Records File: 
 

• Student Name • Number of problems attempted 
• Date • Number of problems answered correctly 
• Name of lesson • Number of minutes spent in the lesson 

 
The teacher can use the recordkeeping system at any time to view this information.  The 
teacher will see a list of the lessons each student has studied, the dates on which they 
used the program, the number of minutes spent in each lesson, and the student’s 
performance in solving problems in each lesson.  This information can be viewed for one 
student, or for all students. The information can be displayed on screen, or on a printed 
report. 
 
NOTE: This program and its recordkeeping system are not designed for network or 
site license use.  It is designed for use on a single computer.  If you wish to use this 
program on more than one computer you may purchase additional copies of the program 
at a special reduced priced (“lab disks”), or you may purchase a site license. 
 
The recordkeeping system can handle up to 50 students. 
 
Using the Recordkeeping System 
 
The recordkeeping system is available through the RECORDS menu.  There are two 
options: Manage Student Names and Manage Student Records. 
 

 
NOTE: Please don’t confuse the 
Recordkeeping System with  
“Session Records”. 
 
“Session Records” show a student 
how well he or she is doing during 
the current session, but are not 
stored after the session has ended. 
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The Recordkeeping System (continued) 
 
 
Manage Student Names 
 
In order to maintain student records, you must first create a Student List of one or more 
names.  A student list is needed to enable students to select their name from the list and 
to “log in”. 
 
The Manage Student Names screen allows you to add and delete student names, and to 
edit student names. 
 
To add a student:  Click the Add a Student button.  Then type the name of the 
 student and click OK. 
 
To delete a student:  Click the student’s name in the Student List.  Then click the 
 Delete a Student button. 
 
To edit a student  Click the student’s name in the Student List.  Then click the 
name: Edit Student Name button.  Type the new name and click OK. 
 
To delete all Click the Erase All Students button. 
student names:  
 
 
Manage Student Records 
 
The Manage Student Records screen allows you to display on the screen, or print, 
records for an individual student or for all students.  You may also erase the records of a 
single student, or all students. 
 
To display the records  Click the Display Records for All Students button. 
for all students:  
 
To print the records  Click the Print Records for All Students button. 
for all students:  
 
To erase the records  Click the Erase Records for All Students button. 
for all students:  
 
To display the records  Click the student’s name in the Student List.  Then click the 
for a single student: Display Records for Selected Student button. 
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The Recordkeeping System (continued) 
 
 
To print the records  Click the student’s name in the Student List.  Then click the 
for a single student: Print Records for Selected Student button. 
 
To erase the records  Click the student’s name in the Student List.  Then click the 
for a single student: Erase Records for Selected Student button. 
 
 
 
The illustration below shows how records are displayed on the screen for a single 
student. 
Notice the sort choices shown at the bottom of the display.  They enable you to sort the 
records by date, by lesson name, or by percent correct. 
 
When you are done viewing the records, click Done to return to the Manage Student 
Records screen. 
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